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0 Hilfsmittel

0.1 SimulIDE

Das kostenlose Elektronik-Simulationsprogramm SimullDE finden Sie in ILIAS unter (DE/EN)

Software.
Alternativ ist das Programm auch Uber die Hersteller-Seite, herunterladbar. Dort muss dann ein

“Obulus” angegeben werden, welcher auch 0€ sein kann.

Im Gegensatz zu TINA Tl hat SimullDE einen anderen Fokus und damit folgende Vor- und Nachteile.

Vorteile:

e Microcontroller wird gut simuliert (u.a. von Atmel Chips). Das ist in TINA TI nicht méglich.
e Die Microcontroller sind auch programmierbar. D.h. man kann Microcontroller-geeignete Source-

File (hex-File) nutzen.
e Interaktion Software und Hardware ist maglich.

Nachteile:

e Simulation von verschiedenen Elektronikkomponenten nur vereinfacht implementiert (z.B.
Operationsverstarker oder FETSs)

¢ Die Software wird noch sehr stark weiterentwickelt. D.h. es ist gut die oben angegebene Version
zu nutzen, um Kompatibilitatsprobleme zu vermeiden.

Zur EinfUhrung in SimullDE hilft es die Playlist des Entwicklers anzusehen.

Tipps fur die Verwendung von Simulide - Konfiguration

{} @_ EII- ﬁ é é @ Speed: D00.00 %

Time: 00:00:00 5 000 ms Q00 ps 000 ns 000 ps

=) Settings ? x

App Circuit Simulation

App Settings Help
Language English -
Font Scale 1.00 =

Fig. 1: Bild zur Konfiguration
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* Falls der Text nach dem Offnen des Programms zu klein dargestellt wird, kann eines der

folgenden Vorgehen helfen:

o Im Programm SimullDE nach dem Offnen auf das Zahnrad klicken. Den Reiter App
auswahlen. Dort bei Font Scale beispielsweise 2,0 eintragen und das Programm neu
starten.

o Im Explorer rechtsklick » Eigenschaften » Kompatibilitat » Hohe DPI
Einstellungen andern » Hohe DPI-Skalierung Uberschreiben » Hakchen
setzen » “System” auswahlen. (ggf. “System (Erweitert)” wahlen)

0.2 Microchip Studio

Microchip Studio ist eine Programmierumgebung, um aus C oder C++ ein Microcontroller-geeignetes
Source-File (hex-File) zu erstellen.

Installation

Installationsanleitung

Die aktuelle Version des Programms finden Sie auf der Microchip-Homepage.

1.

Falls nach dem Drucken des Buttons Download Microchip Studio nichts passiert: einfach
herunterscrollen zu Downloads and Documents

. Bei schnellen Internetverbindungen kann der Web Installer gewahlt werden, bei langsamen

lasst sich mit dem Offline Installer das gesamte Paket vor der Installation herunterladen.
Bei der Installation ist als Architektur nur “AVR” notwendig.
“Advanced Software Framework and Example Projects” sind nicht notwendig

. Die Installation dauert je nach Geschwindigkeit des Rechners und der Internetverbindung etwa

5 Minuten
Falls nicht schon installiert, wird bei der Installation auch Visual Studio mit installiert
Die Frage nach Lizenzen fur den C compiler ist mit Next > zu Uberspringen

. Weiterhin kann es sein, dass verschiedene Gerate-Treiber mit installiert werden. Diese

ermoglichen das Beschreiben der Chips mit einem Programmiergerat.

. Offnen Sie im Anschluss direkt Microchip Studio, damit Sie die ersten, wichtigen Einstellungen

vornehmen konnen.

Erster Test der Verbindung zum AVR-USB-Progi

FUhren Sie folgende Schritte durch, um einen ersten Test mit der Hardware durchzufthren.

1.

2.

Vorbereitungen
1. Verbinden Sie das MiniMEXLE
1. mit dem Proggi (schwarze Box) per Flachbandkabel
2. mit der Steckdose per Ladekabel mit dem Hohlstecker
2. Offnen Sie Microchip Studio (z.B. durch Druck auf die <WIN> Taste und Eingabe von
Microchip Studio, sowie druck auf <Return>).
3. Laden Sie die Datei 5._menufuehrung.hex herunter.
4. Verbinden Sie nach dem Offnen das Progi per USB-Kabel mit dem PC / Laptop. Dieser
Schritt muss vor den folgenden geschehen!
5. Es sollte am Progi die Grune LED fur die USB-Kommunikation leuchten.
USB-Verbindung eintragen
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1. Gehen Sie ohne Erstellen eines Projekts, direkt auf Tools » Add Target...

2. Im dargestellten Fenster sollten Sie beim bisher leer angezeigten Dropdown-Menu als Tool
STK500 auswahlen.

3. Bei der Auswahl des “Serial Ports” sollten Sie den ersten verfigbaren auswahlen z.B.
COM3 und bestatigen Sie die Auswahl mit Apply.

Sollte hier keine Port angezeigt werden, prifen Sie, ob die Verbindung mit dem USB-Progi
erfolgreich war.
Falls die grine LED leuchtet und das USB Kabel korrekt eingesteckt ist, gehen Sie zu den
Hinweisen unter 4.d.

3. Erster Verbindungsversuch

1. Wahlen Sie im Menl Tools » Device Programming aus.

2. Wahlen Sie bei Tools die entsprechende USB-Verbindung aus, z.B. STK500 COM3.

3. Bei Device missen Sie ATmega88 auswahlen, Sie konnen dazu 88 eingeben und im
Dropdownmenu dann den korrekten Wert anklicken.

4. Beim Interface sollte nun ISP stehen

5. Drlcken Sie nun auf Apply.

4. Im Fehlerfall:

1. Falls es nach Druck auf Apply langer dauert, hat die Verbindung nicht geklappt. Es wird
dann eine Fehlermeldung Unable to connect tool STK500 (COMx) angezeigt.

2. Die Fehlermeldung kénnen Sie quittieren, jedoch dauert es danach nochmals einige
Sekunden, bis das Programm wieder korrekt reagiert.

3. SchlieBen Sie dann das Fenster Device Programming. Gehen Sie in dieser Anleitung
zurick zu Punkt 2. und versuchen Sie den nachsten Serial Port.

Merken Sie sich dabei die Nummer des Ports, da diese unter 3.b. bendtigt wird.

4. Wenn alle vorhandenen COM-Ports durchgetestet wurden, oder zu Beginn keiner
angezeigt wurde, kann die Installation eines Virtual COM Port Drivers helfen. Einen
solchen finden Sie unter FTDI.

5. Im Gutfall:

1. Es sollte nun etwas mehr im Fenster Device Programming sichtbar worden sein.

2. SchlieBen Sie vor den nachsten Schritten das MiniMEXLE (= Platine mit Display und
Kndpfen) mit dem Flachbandkabel an das Progi und mit dem Hohlstecker an das Netzteil
an. Stecken Sie das Netzteil auch in eine Steckdose

3. Drucken Sie nun auf Read oben neben Device Signature.

4. Es sollte eine hexadezimale Zahl 0x.... erscheinen. Ihr Rechner kann nun flir das Flashen
eine Verbindung zum MiniMEXLE herstellen.

5. Gehen Sie auf im Fenster Device Programming auf den Punkt Memories. Flgen Sie
unter dem Punkt Flash den Pfad zur heruntergeladenen Datei 5. menufuehrung.hex
ein. Sie konnen dazu auch Uber die ... rechts daneben den Pfad auswahlen

6. Drucken Sie auf Program

7. Auf dem Minimexle sollte nun eine Anzeige
- Experiment 5 -

Programm Menu
und dann
Main Level
P1 P2 P3 P4
erscheinen
8. Damit haben Sie die Verbindung und das Flashen erfolgreich getestet
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wichtige Einstellungen

e Nutzen Sie die Anzeige von Zeilennummern: Tools » Options » Text Editor » All
languages » General » Line numbers
* Sobald Sie das erste Projekt bearbeiten: Deaktivieren Sie unbedingt die Compiler Optimierung.
Dies geht mit folgenden Schritten:
o Menu Project » <ProjectName> Properties.. » AVR/GNU Compiler »
Optimization
o Das Optimization level sollte hier auf None (-00) stehen
e |ch empfehle ATMLE Studio in der Sprache “English” zu nutzen. Damit sind die Hinweise in
diesem Kurs korrekt zu finden. Falls Sie versehentlich (z.B. bei der Installation) die deutsche
Sprache eingestellt hatten, konnen Sie es unter Werkzeuge » Optionen » environment »
international settings » Language korrigieren.

Tipps

e Falls auf der rechten Seite der Solution Explorer (Anzeige der Dateien im Projekt) nicht
vorhanden ist, so finden Sie diesen unter
View » Solution Explorer (<CTL>+<ALT>+<L>)

0.3 MEXLE GitLab

Installation der Software auf lhrem Rechner

1. Laden Sie Git von folgender Seiter herunter: https://git-scm.com/download/win » “Standalone
Installer”

Git bietet die Méglichkeit mit dem GitLab Server der Hochschule oder mit GitHub in Kontakt zu
treten

2. Installieren Sie das Git (alle mit “Ok” bzw “Weiter” bestatigen)

3. Laden Sie TortoiseGit von folgender Seite herunter: https://tortoisegit.org/download/
totroiseGit bindet den Explorer direkt an die Services des Git an. Damit ist Git direkt in den
Explorer eingebunden.

4. Installieren Sie das TortoiseGit (alle Hinweise mit “Ok” bestatigen)

Vorbereitung des Rechners: Installationen und Ordner

1. Melden Sie sich bei GitLab mit den Hochschul-Credentials an: https://git.mexle.org/
2. Gehen Sie zu User settings » Preferences » Password:
z.B. Uber folgenden Link: https://git.mexle.org/-/user_settings/password/edit

GIT O

Veamiir i el

3. Geben Sie ein Passwort mit mindestens 16 Zeichen ein und merken Sie sich dieses Passwort.
Dieses Passwort ermdglicht die Authentifizierung auf GitLab.
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Bitte nutzen Sie ein neues Passwort!

Installation der Software auf lhrem Rechner

Die Abfolge ist wiefolgt:

0 1. Erst mussen Sie sich in GitLab angemeldet habenn
2. Dann mussen Sie einem Betreuer (Prof. Fischer, Ralf Ziegler) per Mail bescheid
geben, damit dieser Sie zum Projekt zuordnet
3. Erst dann sind die folgenden Punkte durchfahrbar.

1. Gehen Sie in den (Windows) Explorer und legen Sie einen neuen Ordner fur die Vorlesung an,
z.B. Mikrocontroller oder Elektronik Labor

2. Klicken Sie mit der rechten Maustaste auf den Ordner, um in des Kontextmenu zu kommen.
Wahlen Sie dort Git Clone... aus.

If_l Git Clone...
| I Gt Create repository here...
&% TortoiseGit >
len Diklinthal afnahenan ™

3. Im erscheinenden GitClone Fenster sollten Sie Folgendes eingeben:
1. als URL: https://git.mexle.org/[Fach]/[Semester].git
also z.B. https://git.mexle.org/mikrocontroller/24ws.git oder
https://git.mexle.org/elektronik/24ws.git fir das Wintersemester 2024
2. als Directory sollte der ausgewahlte Ordner eingetragen sein
3. Klicken Sie nun auf Ok

P~ W W b WA VP S LT Lidl EILILInIET

#" Git clone - TortoiseGit >

Clone Existing Repository

URL: Browse... -
[] Depth 1 [ Recursive ] Clone into Bare Repo [IMo Checkout
[]Branch |:|Clrigir1 Mame

[ Load Putty Key ehret31. Mikrocontrollertechnik\GIT 55H private Key.ppk

From SVN Repository
[ From SVM Repository

Trunk: trunk Tags: tags Branch: branches

From: 0 Uzername:

4. Im Anschluss sollten Sie eine Fehlermeldung erhalten, da noch das Passwort fehlt.
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Hier ist nun das vorher gewahlte Passwort einzugeben.
Dies mlssen Sie auch nur einmalig machen.
5. Der Download sollte nun klappen und es sollten alle Ordner heruntergeladen werden

Upload / Commit von Dateien

Das Hochladen und Andern von Dateien bei Git wird als “Commit” bezeichnet. Diese Nomenklatur
wird auch im Folgenden genutzt.

Im Folgenden wird ein Upload beschrieben; Gber einen Commit kénnen aber auch Dateien geldscht
werden.

1. Rechtsklick auf den ubergeordneten Ordner » Git Commlt -> “main”

7 Git Sync...
& Git Commit -= "main"...
2 TortoiseGit b

In Riklinthel anfrerhmen |
2. Falls eine Fehlermeldung erscheint, siehe nachstes Kapltel

3. Im folgenden Fenster ist nun einiges einzutragen:
1. Tragen Sie unbedingt einen Text unter Message ein, ansonsten ist kein Upload maoglich!
Schreiben sie einen Text, welcher die Anderungen beschreibt.
2. Im unteren Teil sind die zu andernden Dateien zu markieren.
Entweder Sie wahlen die Dateien einzeln aus, oder Sie wahlen z.B. Al1 .
3. Zum Commit an den Server wahlen Sie am Button unten v aus und dort Commit & Push

MEXLE Wiki - https://wiki.mexle.org/
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" DAGitLab\mikrocontreller\2dws - Commit - TortoiseGit — O >
Committo:  main [ ] new branch
Message:
n
7ol

[] Amend Last Commit
[] set author date

[] set author

TimFischer <tim . fischer@hs-heilbron:

Changes made (F5: refresh, double-click on file for diff):

Add Signed-off-by

Check:

All Mone Unversioned

Files

Path

L4

Llot Yersioned Files

| text.bet

>

[ Staging support (EXPERIMEMNTAL)
Show Unversioned Files

[] Do not autoselect submodules

Show Whole Project

[] Message only

Commit & Push

Commit

ReCommit

1 files zelected, 1 files total

Cancel

View Patch> =

Help

Commit & Push

4. Bestatigen Sie nun den Commit Uber Druck auf den Button Commit & Push
4. Uberpriifen Sie, ob der Commit erfolgreich war durch einen Blick auf die Homepage des

Projekts.

Mogliche Fehler

1. fatal: detected dubious ownership in repository at [..] is on a
filesystem that does not record ownership
Das Problem ist, das der Ordner auf einem Laufwerk liegt, welches keine Benutzerzuordnung
erlaubt (z.B. ein USB-Stick) .

Die Losung wird gleich mitgeliefert:
1. Rechtsklick im Explorer auf den entsprechenden Ordner (z.B. 24WS) » Open Git Bash

here » Es offnet sich eine Text-Konsole
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2. Flgen Sie Folgendes ein git config --global --add safe.directory
D:/GitLab/elektronik/24WS (andern Sie ggf. elektronik in mikrocontroller
und das Semester) und bestatigen Sie mit Return
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